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Nayif-1 Dashboard  

Installation and operating guidance notes 

from AMSAT-UK 

  

Release 1.0b – Feb 7th  2017   

  

Overview  

The Nayif-1 Dashboard user interface enables the display of telemetry, debug data and Fitter 

messages from the Nayif-1 spacecraft. It can also upload the received data to the Data Warehouse 

over the internet.  

The Dashboard can accept live inputs from a directly connected FUNcube Dongle (both Pro and Pro+ 

models) or by audio from another SSB radio fed into the computer soundcard. It can also display 

previously recorded data from IQ “WAV” files or from the “.funcubebin” recordings that it can create 

during operation.   

The Dashboard has been tested on a variety of different “Windows” machines, from XP through to  

W10.    

This version, v1038, of the software is being made available prelaunch and it can be evaluated with 

test file that is also in the package   

The Concept of Operations is that the spacecraft should operate in educational mode (high power 

telemetry downlink only) when in sunlight and amateur mode (low power telemetry and 

transponder) when in eclipse. It is intended that the available data from all of the 50+ telemetry 

channels can be used by schools and colleges to demonstrate a wide variety of science in an 

interesting and challenging manner.   

Finally – a respectful request – please read ALL of these notes before diving in and trying to install, 

configure and use the Dashboard. Please note that the authors have assumed that early users will 

already have experience of using a FUNcube Dongle or of using an SSB VHF receiver!  

Pre-Requisites  

Prior to updating your station with the capability to receive the Nayif-1 telemetry, please take a 

moment to ensure that you register at the Nayif-1 Data Warehouse  at  

http://warehouse.funcube.org.uk/ There is a small “register” tab to the top right of the screen. 

 

 

http://warehouse.funcube.org.uk/
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When you have completed registration, you will be emailed with your login details which consists of   

• “Site Id” which is typically your callsign or school name,   

• “Auth Code” which is a unique code used to secure your uploaded data to the warehouse,  

and   

• “URL” which is the default address which have already been loaded into the in the 

programme. 

 Please save this data for entry into the Dashboard software.   

The Dashboard software requires the Microsoft .NET Framework v4.0 to be installed on your 

computer.  Please download this from 

http://www.microsoft.com/engb/download/details.aspx?id=17851 and ensure that Windows 

Update confirms that you have the latest updates installed for it.  

 

Software Installation  

You can download the dashboard from   http://download.funcube.org.uk/Nayif-

1_Dashboard_1038_installer.msi  as a Windows Installer (.msi) file.  Once you have downloaded the 

installer, please ensure that you right-click on the MSI file and select “Properties”.  Ensure that you 

click on the “Unblock” button if it is displayed.  

The dashboard will install directly to your hard disk and you have the option as to which directory 

the dashboard is placed during the installation.  By default, a directory including the release version 

number will be used. 

 

Navigating the Dashboard  

To start the dashboard, double click on the “dashboard.exe” programme or select “Nayif-1 

Dashboard” from the “Start” menu.    

The first screen you will see is shown in Figure 1. There are twelve separate sets of telemetry data 

displayed on the initial Dashboard screen along with a summary set (“Telemetry Decoding”) which 

gives details on how successful the data decoding is progressing.  The last field to appear is usually 

the “Power Tracking Mode” field at the bottom of the EPS frame on the right hand side or may be 

the Telemetry Decoding details. This will depend upon your screen resolution etc.  Please ensure you 

resize the Dashboard so that all the data is visible on your screen.  

http://www.microsoft.com/en-gb/download/details.aspx?id=17851
http://www.microsoft.com/en-gb/download/details.aspx?id=17851
http://www.microsoft.com/en-gb/download/details.aspx?id=17851
http://www.microsoft.com/en-gb/download/details.aspx?id=17851
http://download.funcube.org.uk/Nayif-1_Dashboard_1038_installer.msi
http://download.funcube.org.uk/Nayif-1_Dashboard_1038_installer.msi
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Figure 1 - The Nayif-1Dashboard  

The initial display shown in Figure 1 is the “RealTime” data. Each box of data represents different 

segments of the telemetry. Do not be concerned by the erroneous numbers that initially appear in 

some fields before any real data has been received.  

The Dashboard is comprised of four main “Panels” which can be sized to suit the user.    The four 

panels are:-  

1. The WOD (Whole Orbit Data)/HR (High Resolution) Data Panel.  

2. The Graphing Panel, and  

3. The Debug/Tuning Panel  

4. The Status Bar  

The WOD/HR Data panel is in the upper left of the Dashboard.  This panel is made up of two views 

which are selectable via the “Whole Orbit” and “High Resolution” tabs.  This panel shows the 

different frames of data and clicking on any of the items displays that data in graph form in the 

Graphing Panel.  

The Graphing Panel is the large panel in the upper half of the Dashboard.  The contents of this panel 

can change depending upon the data you are viewing.  The display in Figure 1 shows all the data 

available from the telemetry but graphs and lists of Fitter messages can also be displayed in this 

panel.  Figure 2 shows an example of a graph being displayed in this panel.  

The Debug/Tuning panel is the large panel occupying the lower portion of the Dashboard.  The 

Debug tab was primarily for the use of the developers during the development of the telemetry 
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system and allows for the display of the data in hex form as well as internal data from within the 

Dashboard. When a FUNcube Dongle (Pro or Pro+) is connected to the computer running the  

Dashboard, the “Tuning” part of this panel will show a spectrum of approximately 96kHz – that is 

±48kHz centred on the Dongle frequency. The “AutoTune” toggle enables the system to track 

Doppler shift, or not, as desired by the user.  

When data is being captured via the soundcard or being replayed via a file, the Tuning panel will 

display a spectrum of the received signal.  The width of the spectrum in this case is 48kHz.  

All of these panels can be resized by placing the mouse pointer over the borders until the mouse 

pointer changes.  Once the Dashboard is arranged to suit your PC display, the configuration can be 

saved by selecting the “Window” menu option, followed by “Save Layout”.  The layout can be 

reloaded by using the “Load Layout” menu option.  

The Status Bar is at the very bottom of the Dashboard window.  It holds status information for the 

current Dashboard session.  

 Detailed descriptions of the Dashboard follow with all the functionality in menus, panels and the status 

bar described.    
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Dashboard Menus  
 

“File” Menu  

The file menu contains four options.  

• “Open Session” option enables you to reload the data contained in a specific “.funcubebin” 

file. This data will display on the screen exactly as a live session except it can run a little 

faster.  

• “Capture Session” option enables you to record the data already stored in memory from the 

current session to the hard disk.  Files will be saved in the “.funcubebin” format.  

• The “Settings” option allows for the configuration of the Dashboard.  Please see the 

“Configuring the Dashboard” section later in this document for details.  

• “Exit”.  Terminates the program.  Note that this will terminate the Dashboard completely 

and all data in memory will be lost if it has not already been saved.  

  

“Capture” Menu  

The “Capture” menu has five options.  The main purpose of this menu is to select the input that will 

provide the audio to be decoded by the Dashboard.  

• “Capture from Soundcard” - This option will take the input from the soundcard that has 

been selected in the “Settings” panel.  

• “Capture from FUNcube Dongle” – This option will take the input from a FUNcube Dongle  

(Pro or Pro+) that is connected to your computer and has been selected as the input on the 

“Settings” panel.  Once selected, the “Tuning” display will start showing a spectrum display 

of the dongle passband. . If no FUNcube Dongle is detected, this menu will be greyed out 

and not selectable.  

 

Note that if no FUNcube Dongle is detected, this option cannot be selected.  You can attach 

a FUNcube Dongle whilst the Dashboard software is running and it will be detected.  In this 

case, please return to the “Settings” panel and update the “Input Device” if you wish to 

capture data from the Dongle.  

• “Capture from file” - This option will take the input from a file that is selected and load the 

data in a simulated satellite pass.  The time delay between the samples can be varied by the 

time delay option configured in the “Settings”, “Files” option.. [TO BE IMPLEMENTED]  
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• “Write Capture data to file” – This option will allow the saving of the currently captured data 

to a “.funcubebin” file.  This file can then be replayed later, when required, using the 

“Capture from file” option.  

• “Clear” – This option erases the current captured data from memory.  

“Window” Menu  

The “Window” menu has five options.  

• “Load layout” – The Dashboard will start every time in a default layout.  This option allows 

the user to load a Dashboard layout that has previously been saved using the “Save layout” 

option.  [TO BE IMPLEMENTED]  

• “Save layout” – This option saves the current layout of the Dashboard, including the theme, 

position of the main panels and colour scheme. [TO BE IMPLEMENTED]  

• “Themes” – This option allows you to select different themes for the Dashboard.  There are a 

number of alternatives offered as well as an option to revert to the default theme 

(“Expression Dark”) which is used every time the Dashboard is started.  Note that different 

themes can, and will, change the location of the tabs on the different panels.  

• “Colours” – This option allows you to select from a number of alternative colour options for 

the Dashboard.    

• “Show raw data” – Under normal operation, the raw telemetry numbers are converted to 

show actual values with units of measure.   Selecting this option allows for the raw decoded 

data to be displayed without any additional calculations being carried out.  

  

“Help” Menu  

This menu has only one option which displays details of the Dashboard software, including version 

number and release date. 
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Dashboard Panels  
 

WOD/HR Panel : Whole Orbit tab  

WOD contains specific channels of data, sampled on the spacecraft at one min intervals. These 

telemetry channels can be displayed in graphical form by selecting one of the entries in the list. In 

flight, the spacecraft will store 104 minutes of data. Figure 2 shows an example of some WOD 

displayed as a graph.  

*IMPORTANT* Currently the horizontal time scale is that when the data is displayed by the 

dashboard not when it was actually recorded by the spacecraft. As WOD is only sent in specific 

frames, this can give a distorted view. If you are playing back a recorded .funcubebin file the 

displayed time will be the current time. The zero readings in the image below relate to when the 

spacecraft was “switched off” during testing in the lab. 

 

Figure 2 - Dashboard displaying graphical data  

WOD/HR Panel : High Resolution tab  

These data channels are read every 5 seconds for a minute every alternate minute. Again these can 

be displayed in graphical form. One purpose of having this High Resolution data is to facilitate the 

calculation of the spin rate of the spacecraft.  

    

Graphical Panel : Fitter Messages tab  

 A Fitter message is a 200 character text message that can be transmitted from the Nayif-1 satellite 

as part of the telemetry.  There are a total of six slots transmitted by the spacecraft and new text can 
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be uploaded by Ground Command Stations. It is envisaged that schools wishing to take part in the 

science experiments will design a message for them to receive as part of their experiments with 

Nayif-1.  Details of how to submit Fitter message for uploading by Command Stations will be 

released in due course.   

There are some preloaded Fitter messages stored on the spacecraft before launch. Fitter message 6 

can be switched by Ground Command station from normal text to debug data and we anticipate it 

will spend most of its time in debug mode.   

 

Graphical Panel : Real Time Data tab  

This display shows all the telemetry data on one screen with each type of data contained in separate 

blocks. These channels are read every 5 seconds and display live or, by clicking on the particular title 

header, a graph is displayed.  

Each time you select a particular telemetry channel to plot, the Dashboard will open a new tab in the 

Graphical Panel to display the graph.  Please note, that in its current form, the dashboard can appear 

to freeze, or slow down dramatically, if more than a few graphs are displayed.  

  

Debug/Tuning Panel : Debug tab  

This display allows for the raw hex telemetry to be displayed.  Whilst viewing the hex frames, it is 

possible to copy the last frame, the last 24 frames or all the decoded frames to the clipboard.  The 

data is copied as plain text.  

The debug panel also provides some other displays of data variables that show the settings of some 

of the adjustable parameters that exist within the on board flight software.  More information about 

these will be made available later  

  

Debug/Tuning Panel : Tuning tab  

This is the largest panel at the bottom of the Dashboard and provides a view of the passband when 

the FUNcube Dongle is the primary input source.  The scale on the Tuning Panel is in Hz, centred on 

the frequency specified in the Settings panel, and is updated with the current FUNcube Dongle 

frequency if another application is being used to control the Dongle itself.  There are several 

functions available via the right-click option on a mouse and the display can be manipulated/moved 

around to best suit the requirements of the user.  There is also a “Screenshot” option that allows 

this display to be copied to the clipboard or a file.  

To the right of the tuning display, there are a couple of options available to the user.  The “Auto  

Tune” option is available when the input is selected to the FUNcube Dongle.  This will allow the  

Dashboard to track Doppler Shift within the low/high range specified in the “Low” and “High” input 

fields.  The “Monitor Audio” allows for the received audio to be played through the default speakers 

on the PC.  
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Dashboard Status Bar  

The Dashboard Status Bar provides a wealth of information for the user in terms of the telemetry 

being received and decoded.  Status information is provided as follows:-  

The left hand side of Dashboard has four status fields.  

• Spacecraft Name  – This shows from which spacecraft you are receiving data and is updated 

automatically depending upon the source of the signals.  

• Frame ID – This lists the id of the frame being decoded and what its contents are.  

• Sequence ID – Each frame of data transmitted by the spacecraft is tagged with a unique ID.  

This is the Sequence Number. This counts up by one every time a complete sequence of 24 

frames has been transmitted. The last Sequence Number recorded before it was integrated 

into the Quadpack was 5471 

• Received Command – This field lists the type of the most recent command received by the 

spacecraft from the ground as well as showing a Success/Fail status flag for that command.  

The right hand side of Dashboard has five status fields.  

• FUNcube Dongle – If a FUNcube Dongle has been detected as the program starts, it will 

record in this field that a dongle has been found.  If no FUNcube Dongle is present, this field 

will be empty.  

• Capture Status – This indicates the status of the telemetry decode functions.  It is either 

“Capturing” or “Idle”.  

• Packets Decoded/Missed – This field records the number of packets that have been decoded 

in the current session as well as the number that have been missed.  

• Packets Uploaded/Waiting – this field records the number of decoded packets that have 

been uploaded to the Warehouse and the number waiting to be uploaded along with a 

status of the upload operation to the Warehouse.  Note that if the “Settings” option to 

“Stream Data to Warehouse” is not selected, this field will report “Disabled”.  

• Detected Frequency – This field reports the frequency within the passband where signals are 

being decoded.  

It is possible to reset the decoded and missed message counters by right clicking on the Status Bar 

and selecting the appropriate option.  
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Configuring the Dashboard  
 

To configure the Dashboard for use, there are a number of settings that have to be made.  

These are:-  

1. The Audio Configuration  

2. The Warehouse Connection  

3. Optional Files.  

These settings are access via the “File” menu and the “Settings” option.  Upon selection, a new 

window opens with three tabs labelled “Audio”, “Warehouse” and “Files”.   

  

Audio Configuration  

The Nayif-1 Dashboard is currently written to decode audio supplied from the FUNcube Dongle (both 

the Pro and Pro+ versions), a Soundcard device or a pre-recorded file.  

“Input Device” – This option lists all the audio devices (soundcards, virtual devices and FUNcube 

Dongles) that are presently connected to your computer.  Select a device as the source for the audio 

input.  Note that if you intend to “Capture from Soundcard”, you should select a real soundcard or 

virtual audio device here.  If you intend to “Capture from FUNcube Dongle”, please ensure that you 

select the FUNcube dongle you intend to use – the Dashboard supports multiple FUNcube Dongles 

connected simultaneously and multiple instances of the Dashboard can be run at the same time. 

Note that in this case, the Dashboard will only save the settings for one instance of the Dashboard – 

i.e. it is not possible to store multiple, different, settings for the Dashboard.  

 “Output Device” – The Dashboard is able to output the audio that it has decoded and send it to a 

specific audio output device.  This option allows you to select a device other than the default output 

device for your computer.  

“Frequency Pre-set” - This is an easy method to select the different satellites that the Dashboard has 

been designed to work with and to automatically populate the “FCD Frequency” field  

“FCD Frequency” – This field is automatically populated when the “Frequency Preset” dropdown is 

used or it can be manually populated.  The value selected/entered in this field is used to set the 

centre frequency of the FUNcube Dongle when it is started.  When the Dashboard is set in its normal 

operating mode (i.e. decoding packets), you will then see the spectrum from the Dongle displayed at 

the bottom of the screen in the Tuning Panel.   Note that you may need to adjust your computer 

sound card settings so that a little “noise” is visible at the bottom of the display in the absence of 

any actual incoming signal.   

“FCD Enable Bias T” – This checkbox enables (when ticked) the Bias T function that is available on the 

FUNcube Dongle Pro+.  Bias T places a supply of 5 volts on the antenna  connector and can be used 
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to power remote antenna pre-amplifiers.  Please consult the FUNcube Dongle website for details of 

the maximum current that can be provided to any pre-amplifier. 

Once you have made changes to the Audio settings, press the “Save” button to make the changes 

permanent within the Dashboard.   

  

Warehouse Configuration  

This tab enables the user to set up their personal login to the AMSAT Data Warehouse for Nayif-1 

and to control the streaming of decoded data to the Warehouse.  

The information needed for this part of the configuration is as supplied in the email sent after your 

registration was completed – it is the information as listed in the “Pre-Requisites” section of this 

document.  

 

Files Configuration  

This tab enables you to select whether or not to produce log files (with a .log extension) and where 

these should be placed. These files contain the data in CSV format and are suitable for use by 

schools for research and investigations.  The last tab on this screen relates to the playback speed for 

the .funcubebin files which were created using the “Capture from File” menu option. It is possible to 

adjust the precise speed of playback with this tab. To obtain a realistic speed, i.e. as it was originally 

transmitted by the spacecraft, set the slider to the slowest setting, this will “playback” at one frame 

every 5 seconds.  
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Normal Operation of the Nayif-1 
Dashboard  

 

The Nayif-1 Dashboard is designed to require very little interaction to receive record and decode the 

telemetry from the spacecraft.  

The key steps to making the Dashboard operate and decode data are:-  

1. Ensure that the Audio Configuration is setup as described in this document.  

2. If you have registered at the Nayif-1 Warehouse, select the “Stream to Warehouse” option 

in the Warehouse settings according to whether you wish to submit data to the Warehouse.  

3. From the “Capture” menu, select the “Write capture data to disk” (so you can save the data 

for replay at a later date).  

4. From the “Capture” menu, select the source for your audio.  

5. Sit back and enjoy!  
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Testing your Dashboard Installation  
 

An important step to ensuring your station is ready to receive the Nayif-1 telemetry, is to test the 

installation with some sample files or with a FUNcube Dongle.  

Testing with a FUNcube Dongle  

To use the FUNcube Dongle with the Dashboard, there are a few configuration steps that you need 

to complete to confirm correct operation.  These steps differ according to Dongle version and 

Operating System.  

FUNcube Dongle Pro+ and Windows XP  

Using this combination, simply accept the default settings assigned to the Dongle when you 

connect it to the computer,  

FUNcube Dongle Pro+ and Windows Vista/7/8/10 

When the Pro+ Dongle is first connected to a computer, the FUNcube Dongle Pro is 

configured as a Line-In device by the operating system.  It is not necessary to alter any of the 

default settings that the operating system assigned to the Pro+ Dongle audio device.  

With the FUNcube Dongle plugged into the computer and with no antenna connected to the Dongle, 

start the Dashboard.  Ensure that the audio settings for the Dashboard are configured so that the 

“Input Device” on the “Settings” page is selected to the Dongle.  On the “Capture” menu, select on 

the “Capture from FUNcube Dongle”.  The Dashboard should look like Figure 3.  

  

Figure 3 - Dashboard running with “Capture from FUNcube Dongle”  
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Note how the Tuning window now contains a spectrum display that SDR users will be familiar with.  

This indicates that the Dashboard is successfully receiving audio from the Dongle and processing it to 

produce the spectrum display.  If you have a display like this, your Dongle is working correctly and 

you are ready to receive real telemetry from the satellite.  

At the base of the Green/Red vertical marker, there is a small circle with a dot at its centre.  Placing 

your mouse on this circle and left-clicking allows you to drag the Green/Red bar over the portion of 

the signal that you want the demodulator to process.   

Note that the Red (or Yellow if “Auto Tune is active) line marks the centre of the demodulator whilst 

the Green bar indicates the bandwidth of the demodulator itself.  

It is also possible to reduce the frequency range within which the “Auto Tune” will function buy 

setting the “Low” and “High” tuning range.  This can be done manually or graphically.  

To set the range manually, simply enter the lower and upper frequency ranges and the Tuning panel 

will look like Figure 10.  The white area between the two red boundaries now indicates the 

frequency range over which the “Auto Tune” function will function.  

To set the limits graphically, place the mouse in the Tuning panel and, with the left mouse button 

held down, move the mouse slightly to the right.  This will expose a vertical line at the extreme left 

of the signal.  Where the signal intercepts with this vertical line, there is a small circle.  Clicking on 

this circle and moving it to the right increases the lower frequency value for the “Auto Tune” range.  

A similar process on the extreme right hand side of the Tuning panel allows for the upper frequency 

value to be set graphically – see figure 10.  

 

  

Figure 10 - Tuning Panel showing a restricted Auto Tune Range  
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TheNayif-1 Data Warehouse  
 

The Data Warehouse enables listeners to upload the data they receive it to a central data 

warehouse. It also enables those without their own receivers to track what is happening, live, on the 

spacecraft. We are hoping that everyone will register at http://warehouse.funcube.org.uk/  so that 

the maximum amount of data can be collected from the spacecraft.   

Although the spacecraft downloads some “Whole Orbit Data” channels, it will be very useful, to help 

the Command Team safely manage the spacecraft, if we receive Real Time and Righ Res data from all 

over the world.    

The Data Warehouse will also make it possible for any user to download historical datasets in .csv 

format for educational research.   

     

http://warehouse.funcube.org.uk/
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FAQs  
 

    

Does this software work on Linux and Mac OS systems?  

Not yet, however there are a number of projects in progress to provide decoders for these platforms.  

 

Is there an iPad or Android app that does the same job?   

 As above - not yet 

Will this software work directly with any other type of SDR Dongle?  

It is possible to use other types of SDRs with the usual types of software such as SDR# or SDR-Radio 

and to use an internal audio loopback device or a software audio device such as Virtual Audio Cable 

etc.  

I can’t get the Dashboard to work with my FUNcube Dongle or particular soundcard?   

Please double check the settings you have selected in the “Settings” panel for “Input Device” and the 

device you have selected in the “Capture” menu – they MUST be of the same type. That is, if the 

“Input Device” is set to a FUNcube Dongle, then the “Capture” must be set to the FUNcube Dongle.  

Setting the “Input Device” to be a FUNcube Dongle but setting the “Capture” to be from a soundcard 

will give a display in the Tuning panel but it will not be what you are expecting!  

On the “Telemetry Decoding” data shown on the “Real Time” display, what does “Error Count” mean?  

Each frame of data transmitted from the spacecraft is 5200 bits with the telemetry data taking up 

2400 bits.  The difference is the extra coding that is applied by the FEC facility at the satellite.  

The “Error Count” displayed on the “Real Time” data represents the number of bit errors detected and 

corrected by the software when decoding each frame of telemetry.  

    

What sort of antenna will I need to use to receive the data from Nayif-1?  

When Nayif-1 is operating in “educational” mode then the telemetry transmitter output power will be 

approx 400mW In this configuration we expect that it will be possible to receive good data with  a 

simple  omni-directional antenna such as a turnstile. When the spacecraft is operating in “amateur” 

mode, the telemetry power will be approx 9dB lower and therefore a steerable antenna with approx 

10dB gain will be required for tlm reception. In amateur mode the transponder will also be active. 

Circular polarisation, and where appropriate, mast head preamps, are recommended. The spacecraft 

will operate in “safe” mode immediately after launch. In this mode the transmitter sends low power 

telemetry only.   
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REVISION DETAILS  

 

  

Issue  Date  Description  

Release 1.0  1st February 2017   Initial Release to support Dashboard version 1038 

Release 1.0b 7th February 2017 Updated with finalised link URLs 

  


